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Preface

Revised: February 20th, 2009, OL-18666-01
The following manual relates to the operation of the Cisco Unified Enterprise Attendant Console 
(CUEAC) software product ranges. 

Cisco Unified Enterprise Attendant Console is an efficient application specially designed for handling 
calls and messages. This application enables you to answer calls from predefined set of queues and 
transfer them to desired extensions.

The application enables you to perform comprehensive tasks like Call Conference, Call Transfer, Call 
Parking and Call Retrievals. The user-friendly design of the application gives speed and flexibility and 
facilitates you to manipulate calls with simple mouse clicks or keystrokes.

The screen-based operator console that has been developed to work exclusively on Cisco Unified 
Communications Manager. The traditional functions of a telephone switchboard have been re-created as 
a Windows application. It is visually more appealing, easier to operate and more user friendly.

Figure i-1 displays the default layout of the Cisco Unified Enterprise Attendant Console
vii
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Purpose of this Guide
The purpose of this user guide is to, 

1. Provide information on configuring and initializing the Attendant Console. 

2. Instruct you to perform actions related to answering, holding, receiving, conferencing, and 
transferring calls. It also discusses procedures for toggling, making and retrieving calls.

Who Should Read this Guide
The document is intended for,

1. Those involved in the training of Cisco Unified Enterprise Attendant Console

2. Users of Cisco Unified Enterprise Attendant Console

How this Guide is Organized
The user guide is split into four main sections. These sections explain the functionality in a way that the 
users can easily get familiar with the Attendant Console, perform different actions and customize it. The 
following table provides the organization of this guide,

Conventions
This document uses the following conventions.

Table 1 Shows the sections of the user guide

Part Description

Getting Started This section explains the interface of the 
Attendant Console. The basic functions of 
starting up and logging into the application are 
explained here.

Customizing Attendant Console This section guides you to customize the 
application. Different configurations and 
preferences are also explained in this section.

Using Attendant Console This section covers topics on answering and 
clearing calls, taking notes, holding, transferring 
and making calls.

Table 1: 

boldface font Commands and keywords are in boldface.

italic font Arguments for which you supply values are in italics.

[   ] Elements in square brackets are optional.
viii
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{ x | y | z } Alternative keywords are grouped in braces and separated 
by vertical bars.

[ x | y | z ] Optional alternative keywords are grouped in braces and 
separated by vertical bars.

String A nonquoted set of characters. Do not use quotation marks 
around the string or the string will include the quotation 
marks.

screen font Terminal sessions and information the system displays are 
in screen font.

Boldface screen 
font

Information you must enter is in boldface screen font.

italic screen font Arguments for which you must supply values are in italic 
screen font.

This pointer highlights an important line of text in an 
example.

^ The symbol ^ represents the key labeled Control-for 
example, the key combination ^D in a screen display means 
you hold down the Control key while you press the D key.

<   > Nonprinting characters, such as passwords, are in angle 
brackets.

Table 1: 

→

Table 2 Shows the writing conventions followed in the user guide

Convention Description
boldface font Commands and keywords are in boldface.
italic font Arguments for which you supply values are in ital-

ics.
[   ] Elements in square brackets are optional.
{ x | y | z } Alternative keywords are grouped in braces and 

separated by vertical bars.
[ x | y | z ] Optional alternative keywords are grouped in 

braces and separated by vertical bars.
String A nonquoted set of characters. Do not use quotation 

marks around the string or the string will include 
the quotation marks.

screen font Terminal sessions and information the system 
displays are in screen font.

Boldface screen font Information you must enter is in boldface screen 
font.

italic screen font Arguments for which you must supply values are in 
italic screen font.
ix
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Notes use the following conventions:

Note Means reader take note. Notes contain helpful suggestions or references to material not covered in the 
publication.

Timesavers use the following conventions:

Timesaver Means the described action saves time. You can save time by performing the action described in the 
paragraph.

Tips use the following conventions:

Tip Means the information contains useful tips.

Cautions use the following conventions:

Caution Means reader be careful. In this situation, you might do something that could result in equipment damage or 
loss of data.

Warnings use the following conventions:

Warning This warning signal means danger. You are in a situation that could cause bodily injury. 
Before you work on any equipment, you must be aware of the hazards involved with 
electrical circuitry and familiar with standard practices for preventing accidents.

Obtaining Documentation
Cisco documentation and additional literature are available on Cisco.com. Cisco also provides several 
ways to obtain technical assistance and other technical resources. These sections explain how to obtain 
technical information from Cisco Systems.

This pointer highlights an important line of text in 
an example.

^ The symbol ̂  represents the key labeled Control-for 
example, the key combination ^D in a screen 
display means you hold down the Control key while 
you press the D key.

<   > Nonprinting characters, such as passwords, are in 
angle brackets.

Table 2 Shows the writing conventions followed in the user guide

Convention Description

→
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Preface
Cisco.com
You can access the most current Cisco documentation at this URL:

http://www.cisco.com/techsupport

You can access the Cisco website at this URL:

http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Product Documentation DVD
The Product Documentation DVD is a comprehensive library of technical product documentation on a 
portable medium. The DVD enables you to access multiple versions of installation, configuration, and 
command guides for Cisco hardware and software products. With the DVD, you have access to the same 
HTML documentation that is found on the Cisco website without being connected to the Internet. 
Certain products also have .PDF versions of the documentation available.

The Product Documentation DVD is available as a single unit or as a subscription. Registered Cisco.com 
users (Cisco direct customers) can order a Product Documentation DVD (product number 
DOC-DOCDVD= or DOC-DOCDVD=SUB) from Cisco Marketplace at this URL:

http://www.cisco.com/go/marketplace/

Ordering Documentation
Registered Cisco.com users may order Cisco documentation at the Product Documentation Store in the 
Cisco Marketplace at this URL:

http://www.cisco.com/go/marketplace/

Non-registered Cisco.com users can order technical documentation from 8:00 a.m. to 5:00 p.m. (0800 to 
1700) PDT by calling 1 866 463-3487 in the United States and Canada, or elsewhere by calling 011 408 
519-5055. You can also order documentation by e-mail at tech-doc-store-mkpl@external.cisco.com or 
by fax at 1 408 519-5001 in the United States and Canada, or elsewhere at 011 408 519-5001.

Documentation Feedback
You can rate and provide feedback about Cisco technical documents by completing the online feedback 
form that appears with the technical documents on Cisco.com.

You can submit comments about Cisco documentation by using the response card (if present) behind the 
front cover of your document or by writing to the following address:

Cisco Systems

Attn: Customer Document Ordering

170 West Tasman Drive

San Jose, CA 95134-9883

We appreciate your comments.
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Cisco Product Security Overview
This product contains cryptographic features and is subject to United States and local country laws 
governing import, export, transfer and use. Delivery of Cisco cryptographic products does not imply 
third-party authority to import, export, distribute or use encryption. Importers, exporters, distributors 
and users are responsible for compliance with U.S. and local country laws. By using this product you 
agree to comply with applicable laws and regulations. If you are unable to comply with U.S. and local 
laws, return this product immediately.

A summary of U.S. laws governing Cisco cryptographic products may be found at: 
http://www.cisco.com/wwl/export/crypto/tool/stqrg.html. If you require further assistance please 
contact us by sending email to export@cisco.com.

Cisco provides a free online Security Vulnerability Policy portal at this URL: 

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html

From this site, you will find information about how to:

1. Report security vulnerabilities in Cisco products.

2. Obtain assistance with security incidents that involve Cisco products.

3. Register to receive security information from Cisco.

A current list of security advisories, security notices, and security responses for Cisco products is 
available at this URL:

http://www.cisco.com/go/psirt

To see security advisories, security notices, and security responses as they are updated in real time, you 
can subscribe to the Product Security Incident Response Team Really Simple Syndication (PSIRT RSS) 
feed. Information about how to subscribe to the PSIRT RSS feed is found at this URL:

http://www.cisco.com/en/US/products/products_psirt_rss_feed.html

Reporting Security Problems in Cisco Products
Cisco is committed to delivering secure products. We test our products internally before we release hem, 
and we strive to correct all vulnerabilities quickly. If you think that you have identified a vulnerability 
in a Cisco product, contact PSIRT:

For Emergencies only-security-alert@cisco.com

An emergency is either a condition in which a system is under active attack or a condition for which a 
severe and urgent security vulnerability should be reported. All other conditions are considered 
nonemergencies.

For Nonemergencies-psirt@cisco.com

In an emergency, you can also reach PSIRT by telephone:

1 877 228-7302

1 408 525-6532

Tip We encourage you to use Pretty Good Privacy (PGP) or a compatible product (for example, GnuPG) to 
encrypt any sensitive information that you send to Cisco. PSIRT can work with information that ha been 
encrypted with PGP versions 2.x through 9.x. 
Never use a revoked or an expired encryption key. The correct public key to use in your correspondence 
xii
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with PSIRT is the one linked in the Contact Summary section of the Security Vulnerability Policy page 
at this URL: 
http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html 
The link on this page has the current PGP key ID in use. If you do not have or use PGP, contact PSIRT at the 
aforementioned e-mail addresses or phone numbers before sending any sensitive material to find other means 
of encrypting the data.

Obtaining Technical Assistance
Cisco Technical Support provides 24-hour-a-day award-winning technical assistance. The Cisco 
Technical Support & Documentation website on Cisco.com features extensive online support resources. 
In addition, if you have a valid Cisco service contract, Cisco Technical Assistance Centre (TAC) 
engineers provide telephone support. If you do not have a valid Cisco service contract, contact your 
reseller.

Reporting Security Problems in Cisco Products
The Cisco Technical Support & Documentation website provides online documents and tools for 
troubleshooting and resolving technical issues with Cisco products and technologies. The website is 
available 24 hours a day, at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support & Documentation website requires a Cisco.com user 
ID and password. If you have a valid service contract but do not have a user ID or password, you can 
register at this URL:

http://tools.cisco.com/RPF/register/register.do

Note Use the Cisco Product Identification (CPI) tool to locate your product serial number before submitting a web 
or phone request for service. You can access the CPI tool from the Cisco Technical Support & Documentation 
website by clicking the Tools & Resources link under Documentation & Tools Choose Cisco Product 
Identification Tool from the Alphabetical Index drop-down list, or click the Cisco Product Identification 
Tool link under Alerts & RMAs. The CPI tool offers three search options: by product ID or model name; by 
tree view; or for certain products, by copying and pasting show command output. Search results show an 
illustration of your product with the serial number label location highlighted. Locate the serial number label 
on your product and record the information before placing a service call.

Submitting a Service Request
Using the online TAC Service Request Tool is the fastest way to open S3 and S4 service requests. (S3 
and S4 service requests are those in which your network is minimally impaired or for which you require 
product information.) After you describe your situation, the TAC Service Request Tool provides 
recommended solutions. If your issue is not resolved using the recommended resources, your service 
request is assigned to a Cisco engineer. The TAC Service Request Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest
xiii
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For S1 or S2 service requests, or if you do not have Internet access, contact the Cisco TAC by telephone. 
(S1 or S2 service requests are those in which your production network is down or severely degraded.) 
Cisco engineers are assigned immediately to S1 and S2 service requests to help keep your business 
operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)

EMEA: +32 2 704 55 55

USA: 1 800 553-2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity
To ensure that all service requests are reported in a standard format, Cisco has established severity 
definitions.

Severity 1 (S1)-An existing network is down, or there is a critical impact to your business operations. 
You and Cisco will commit all necessary resources around the clock to resolve the situation.

Severity 2 (S2)-Operation of an existing network is severely degraded, or significant aspects of your 
business operations are negatively affected by inadequate performance of Cisco products. You and Cisco 
will commit full-time resources during normal business hours to resolve the situation.

Severity 3 (S3)-Operational performance of the network is impaired, while most business operations 
remain functional. You and Cisco will commit resources during normal business hours to restore service 
to satisfactory levels.

Severity 4 (S4)-You require information or assistance with Cisco product capabilities, installation, or 
configuration. There is little or no effect on your business operations.

Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is available from various online 
and printed sources.

 • The Cisco Product Quick Reference Guide is a handy, compact reference tool that includes brief 
product overviews, key features, sample part numbers, and abbreviated technical specifications for 
many Cisco products that are sold through channel partners. It is updated twice a year and includes 
the latest Cisco offerings. To order and find out more about the Cisco Product Quick Reference 
Guide, go to this URL:

http://www.cisco.com/go/guide

 • Cisco Marketplace provides a variety of Cisco books, reference guides, documentation, and logo 
merchandise. Visit Cisco Marketplace, the company store, at this URL:

http://www.cisco.com/go/marketplace/

 • Cisco Press publishes a wide range of general networking, training and certification titles. Both new 
and experienced users will benefit from these publications. For current Cisco Press titles and other 
information, go to Cisco Press at this URL:

http://www.ciscopress.com
xiv
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 • Packet magazine is the Cisco Systems technical user magazine for maximizing Internet and 
networking investments. Each quarter, Packet delivers coverage of the latest industry trends, 
technology breakthroughs, and Cisco products and solutions, as well as network deployment and 
troubleshooting tips, configuration examples, customer case studies, certification and training 
information, and links to scores of in-depth online resources. You can access Packet magazine at this 
URL:

http://www.cisco.com/packet

 • iQ Magazine is the quarterly publication from Cisco Systems designed to help growing companies 
learn how they can use technology to increase revenue, streamline their business, and expand 
services. The publication identifies the challenges facing these companies and the technologies to 
help solve them, using real-world case studies and business strategies to help readers make sound 
technology investment decisions. You can access iQ Magazine at this URL:

http://www.cisco.com/go/iqmagazine

 • or view the digital edition at this URL:

http://ciscoiq.texterity.com/ciscoiq/sample/

 • Internet Protocol Journal is a quarterly journal published by Cisco Systems for engineering 
professionals involved in designing, developing, and operating public and private internets and 
intranets. You can access the Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

 • Networking products offered by Cisco Systems, as well as customer support services, can be 
obtained at this URL:

http://www.cisco.com/en/US/products/index.html

 • Networking Professionals Connection is an interactive website for networking professionals to share 
questions, suggestions, and information about networking products and technologies with Cisco 
experts and other networking professionals. Join a discussion at this URL:

http://www.cisco.com/discuss/networking

 • World-class networking training is available from Cisco. You can view current offerings at this 
URL:

http://www.cisco.com/en/US/learning/index.html
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C H A P T E R 1

Getting Started

Revised: February 20th, 2009, OL-18666-01
Cisco Unified Attendant Console must have the relevant telephony software and hardware installed and 
configured. For details see, Cisco Unified Enterprise Attendant Admin Web Admin /Installation Guide. 
Contact your system administrator to configure your system.

Accessibility for Users with Disabilities
Cisco Unified Enterprise Attendant Console provides accessibility features that make it easier for blind 
and visually impaired users to use the application.

Attendant Console provides the ability to customize the appearance of the application making it simpler 
for users with low vision to adjust the look of the console. This allows users to work in the manner that 
they find most comfortable. To access the console settings choose Options>Preferences from the menu 
bar.

The software can be used with a mouse as well as keyboard navigations. The keyboard navigations have 
been listed in the following section. For the user’s convenience graphical buttons are also available. Each 
icon displays a tool tip when the mouse is hovered on it, clearly defining the function of the graphic 
button. A list of icons along with their descriptions has also been provided in the following sections.

Attendants also have an option to use Cisco Unified Enterprise Attendant Console with a screen reader 
plug in called JAWS. The screen reader provides the attendant with information on the status of the 
attendant console as well as with information about the text in the attendant console windows.

Cisco Unified Enterprise Attendant Console also comes with context-sensitive help. For every page, 
users can access help specific to a window or a field by simply clicking F1.

For more information on Cisco Accessibility Program please contact through the following link,

http://www.cisco.com/web/about/responsibility/accessibility/contact.html

Using the Keyboard 
Most of the operations can be performed through mouse clicks; however, you can also use the keyboard 
to perform call control operations. The functional keys that can be used to operate Attendant Console 
are next.
1-1
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Chapter 1      Getting Started
  Using the Keyboard
Key Descriptions
Table 1-1 Shows the functions that can be performed using the keys mentioned

Key Name Description
F1 Help
F2 Alternative Numbers, BLF and Presence Status
F3 Internal Directory Field
F4 External Directory Field
F5 Call Progress Field
F6 Speed Dials Field
F7 Active Calls Field
F8 Queued Calls Field
F9 Queues Field
F10 Go Unavailable
F12 Contact Details
Backspace Number Correction. Cancels the misdialed numbers
Insert Camp on. Used to stack a call against a busy extension.
Delete Re-establish. Retry a call.
Page Down Hold/Retrieve. One key depression places the call on Hold. Pressing the key 

again retrieves the held call. Any call that returns to the Call Progress Field; for 
example, no reply or a parked call is retrieved in the same way

Enter Connect/Clear. Either connects the call or clears the call down depending on the 
operating transaction in process 

Plus Answer Next/Toggle. Answers the next highest priority call or when offering a 
call will toggle between calling and called parties

Minus Cancel Consult. Having offered a call, if the called party refuses, the key will 
drop the called party and the calling party is in circuit

Home Call Park. Press to park a call on a park extension number
End Conference. Used to start the conference procedure and then add parties
Context Key

Used to bring up the associated menu in the highlighted Field Header, use   to 
required item and Enter key to select

Space Bar Used to delete the number whilst in the process of dialing out 
Tab Key Used to jump across Directory search Fields
1-2
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Chapter 1      Getting Started
  Logging In
Additional Functions
You can perform additional functions using the CONTROL (Ctrl) key. These are explained in the 
following table. 

Logging In
You must log in to the application with your Login Name, Password and Extension number. Each user 
has a unique identity to log in to Attendant Console. Logging on to Attendant Console also logs you on 
to Cisco Unified Attendant Server. After logging on successfully you can process both internal and 
external calls.

To login,

Step 1 Choose File > Login, this will open the Login window,

Table 1-2 Shows combination keys used to perform certain operations

Key Combination Description

Ctrl^F2 Used to display the Lateral Search (Cross 
tab)within the directories. This requires enabling in 
Preferences

Ctrl^F5 Used to Display My Camped on Calls

Ctrl^M Used for sending an email to an extension user not 
responding to a call

Ctrl^E Used to force the queues into emergency mode
Ctrl^Q Used to Mute a call when certain actions are taken. 

This is set up in preferences and the actions include 
Performing a Search, Pressing numeric keys to dial 
numbers or Changing or Selecting Directory 
screens.

Ctrl^R Used to reclaim a call
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Figure 1-1 Displays the window used to log into the application

Step 2 Type Login Name and Password.

Step 3 Enter Extension.

Step 4 Choose a device type, that is, Headset or Handset.

Step 5 Click Login.

The following table explains the fields mentioned in the Login window.

The Extension number that is entered during login must be the Primary Number for a device. It is 
possible that the same extension number might be configured as a primary number for another device on 
a different partition. In order to differentiate between the two devices configured on the same extension 
number, the MAC address can be used to identify each device. A MAC address is a unique identifier for 
each device.

During login, if multiple instances exist in Cisco Unified Communciations Manager for the directory 
number you entered, a Duplicate Device window will be displayed. You can select a MAC address and 
view the relevant details for the directory number and select the correct device as shown in the window 
below,

Table 1-3 Explains the fields displayed in the Login window

Field Example Description

Operator Details

Login Name OPERATOR1 You must provide a login name here in order 
to log into the application.

Password *** The password is required for secure login.

Device Details

Extension 1000 Enter the extension number you are using to 
handle calls.

Type Handset You can select the type of device you wish to 
use. You have a choice between headset or 
handset.
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Figure 1-2 Displays the Duplicate Device window with information for the selected device

When you select a MAC address, the following information for the selected MAC Address is displayed 
as configured in Cisco Unified Communications Manager.

Once the extension is selected, the application will initialize using the selected number. The selected 
extension will be used for subsequent sessions from the same PC.

Please note that Shared Lines are NOT supported as Operator phones for technical reasons. 

Go Unavailable (F10)
You can take a break by going unavailable for a specific time. The calls will still appear on the console 
but you will not be able to answer them. The short cut key for going Unavailable is F10. Pressing F10 
will display the following window.

Table 1-4 Describes the fields in the Duplicate Device window

Field Example Description

MAC Address SEP00141C48DDD9 This field specifies the MAC Address. This 
is the unique identifier for a device. If the 
directory number for a device has multiple 
instances in Cisco Unified Communications 
Manager, the MAC Address is used to 
identify the relevant device.

Directory Number 5351 The number used by the operator to log in.

Description Auto5351 This field provides the description for the 
device.

Route Partition FACAccess The route partition the extension 

is configured on.

Calling Search Space FACAccess The calling search space the extension is 
configured on.
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Figure 1-3 Displays the Go Unavailable window

To become available, click Go Available (F10).

Interface
The main interface of Attendant Console consists of the following areas, 

1. Menu Bar

2. Tool Bar

3. Queues (F9)

4. All Queues (F8)

5. Active Calls Area (F7)

6. Internal Directory (F3) and External Directory (F4)

7. Call Progress Area (F5)

8. Call Parking Devices Field

9. Speed Dials Area (F6)

Figure 1-4 CIsco Unified Enterprise Attendant Console interface
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Menu Bar

Tool Bar
The Call Control toolbar is located between the Queued Calls and Active Calls areas. It shows icons for 
all the call control operations available at any given time. 

Table 1-5 Lists the menu items along with the descriptions

Control Name Description

File

Login This option is used to login. 

Log out This option logs you out from Attendant Console.

Exit This option is used to close the application.

View

Tool Bar This option activates/deactivates Call Control 
tool bar.

Queues This option allows you to either View All Queues 
or View Individual Queues.

Speed Dial This option activates/deactivates Speed Dial field.

Display Salutation This option enables/disables the Salutation 
Window.

Display My Camped on Calls This option enables/disables the display of 
camped on calls. The shortcut for this function is 
(CTRL^F5).

Options

Preference This option opens the preferences window to 
customize Attendant Console.

Emergency The option allows you to send all the queues in 
Emergency Mode. All calls will be forwarded to a 
preconfigured destination.

Filter Searching You can select to switch on phonetic searching 
from this menu.

Help

Contents It opens on-screen help.

Keyword Search Allows you to use keywords to search the help 
file.

Graphics Displays a graphic panel that displays all of the 
graphic icons used within the Attendent Console.

About Attendant Console It displays the version and copyright information.
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Figure 1-5 Displays the Call Control toolbar

The Call Control toolbar has the following options.

Right clicking on a call in the Active Calls area and choosing an option from the context menu can also 
perform the above-mentioned operations. You can also access these options using your keyboard (Please 
refer to Chapter 1 Getting Started, Using the Keyboard section).

Table 1-6 Displays Call Control toolbar options

Control Name Icon Description

Answer Call Click to answer a ringing call (not a queued call).

Mute Call Click to Mute a Call

Clear Call Click to clear an active call. 

Transfer Call Click to transfer the answered call to another 
extension. 

Retrieve Call Click to retrieve a held call.

Toggle Call Use this option to switch between Active and Held 
calls.

Re-establish Click to redo an action previously performed on a 
call. 

Hold with Notes Click to attach information notes to the current call 
before placing the call on hold.

Note The notes are for your use, 
and do not get sent on with 
the call.

Hold Click to place a specific call directly on hold.

Contact Properties Click to view contact details of the caller. 

Start Conference Click to consult and start conference with another 
user.

Conference Click to bring the parties together inconference.

Camp on Click to transfer a call to a busy extension.

Park Call Click to place the call on a call parking device.
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Queues (F9) 
The Queues field of the application displays the queues that are available to the logged in operator. Each 
icon represents a different queue. When an incoming call is delivered to the queue, a numeric indicator 
appears indicating the number of calls waiting to be answered. A ringing tone is heard by the caller until 
the call is answered.

The following icons are displayed in this area.

The following functions can be performed on the calls in this area using the keyboard,

Right click on a call in the Queues area and choosing an option from the context menu can also access 
the above-mentioned options.

All Queues (F8)
This field displays calls that are waiting in queues. The calls are displayed with the following 
information,

 • Name of the caller

 • Number of the caller

 • Elapsed time the call has been waiting in queue

 • Name of the queue (optional)

Table 1-7 Describe icons appearing in the Queues area

Icons Types of Queues

This is for the Console Queues that are active and 
ready to receive calls.

This icon represents the queues that are currently 
in night service.

This is for the Queues that are in Emergency 
mode.

Table 1-8 Describes the combination key for Emergency Mode

Key Function

Ctrl^E Used to force the queues into emergency mode
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Figure 1-6 Displays the All Queue field

The following functions can be performed on the calls in this area using the keyboard,

The above-mentioned options can be accessed through the right click context menu. 

Active Calls (F7)
The Active Calls area displays calls that are being processed. You can view call information such as,

 • Name of the queue

 • Current status of the call, that is, Held, Calling, Talking or Busy

Figure 1-7 Displays the Active Calls area

The following keys are used in this area,

Table 1-9 Explains the function keys for All Queues area

Key Function

+ Answers the next incoming call.

Enter Press to answer the incoming call.

Table 1-10 Explains keys used to handle calls in through Active Calls Area

Key Function

Enter Press to answer the incoming ringing call.

Enter Press to clear the connected call.

Enter Press to complete the Consult Transfer of the call.
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Right clicking on a call in the Active Calls area and choosing an option from the context menu can also 
access the above-mentioned options.

Directories
There are two directories in Attendant Console, 

 • Internal Directory (F3)

 • External Directory (F4)

Internal Directory (F3)

The Internal Directory provides a list of available internal extensions. For each contact, Internal 
Directory displays,

 • First Name

 • Last Name

 • Department

 • Job Title

 • Extension Number

 • Email

These are the default settings and can be changed.

PgDn Press to hold.

PgDn Press to retrieve the held call.

- Press to cancel Consult Transfer.

End Press to start and join all parties in Conference.

Delete Press to re-establish a call.

F2 Press to display Alternative Numbers, BLF and 
Presence Status.

F12 Press for Contact Details

Home Press to park the answered call on a device.

Ctrl^M Used for sending an email to an extension user not 
responding to a call

Table 1-10 Explains keys used to handle calls in through Active Calls Area

Key Function
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Figure 1-8 Displays the Internal Directory field

Call control operations can be performed on the contacts in the Internal Directory in the following ways,

 • Using the mouse, select a contact in the directory and click any call control button on the call control 
toolbar. These buttons have been explained in the previous sections.

 • Right-click a contact and choose an option from the context menu.

 • Use the keyboard shortcuts to perform call control operations as explained in the previous sections.

The following icons may appear next to a contact in the Internal Directory field.

Table 1-11 Explains icons displayed next to contacts in the Internal Directory field

Icon Description

Indicates the Presence status of the Contact.

Indicates the status of the extension.

Indicates that the contact has some notes attached.

Indicates that an alternate number has been specified for the contact,or one of 
the following fields have an entry in the Contact Numbers:-

 • Mobile

 • Business 1

 • Business 2

 • Home

Table 1-12 Explains keys used for functions within Internal Directory

Key Function

Ctrl^F2 (preference 
specific - See Chapter 2, 
“Filter Search ’on page 
”2 - 12) 

Open a Lateral Search for alternative colleagues of the selected contact. 
This search will be on the category that has been set within the preferences.

When the Lateral Search window opens the criteria will appear in the 
heading.

The Lateral Search window can be moved or reshaped as required.

F2 Opens BLF, Presence Status and Alternative Numbers

F12 Opens Contact Properties.
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External Directory (F4)

The External Directory provides a list of available external numbers for internal contacts.

Figure 1-9 Displays the External Directory field

Call control operations can be performed on the contacts in the External Directory in the following ways,

 • Using the mouse, select a contact in the directory and click any call control button on the call control 
toolbar. These buttons have been explained in the previous sections.

 • Right-click a contact and choose an option from the context menu.

 • Use the keyboard shortcuts to perform call control operations as explained in the previous sections.

Each External contact number displays an icon representing the type of telephone number such as 
Mobile, Business, Home, with the contact’s First Name, Last Name and Company Name. 

The following icons may appear next to a contact in the External Directory field.

Table 1-13 Explains icons displayed next to contacts in the External Directory field

Icons Description

Indicates the Presence status of the Contact.

Indicates the type of contact number being used, 
for example,  Mobile,  Business,  Home, 

 Fax or  Pager.

Indicates that the contact has some notes attached.

Indicates that an alternate number has been 
specified for the contact,or one of the following 
fields have an entry in the Contact Numbers:-

 • Mobile

 • Business 1

 • Business 2

 • Home
1-13
Cisco Unified Enterprise Attendant Console User Guide

OL-18666-01



Chapter 1      Getting Started
  Interface
Table 1-14 Explains keys used for functions within External Directory

Call Progress (F5)
The Call Progress field displays two types of calls,

1. Calls that are placed on hold. 

2. Timed-out (returned) calls that were transferred or parked on a device.

You can retrieve or re-establish a call from the Call Progress area in the following ways,

 • Using the mouse, select a call in the Call Progress area and click any call control button on the call 
control toolbar. These buttons have been explained in the previous sections.

 • Right click a call and choose an option from the context menu.

 • Use the keyboard shortcuts to perform call control operations as explained in the previous sections.

The following information is displayed for each call,

Key Function

Ctrl ^F2 (preference 
specific, see Chapter 2, 
“Filter Search ’on page 
”2 - 12) 

Open a Lateral Search for alternative colleagues of the selected contact. 
This search will be on the category that has been set within the preferences..

When the Lateral Search window opens the criteria will appear in the 
heading.

The Lateral Search window can be moved or reshaped as required.

F2 Opens BLF, Presence Status and Alternative Numbers

F12 Opens Contact Properties.

Table 1-15 Explains fields displayed for a call in the Call Progress area

Control Name Description

Call Progress Displays the caller’s number.

Time It is the elapsed waiting time of the caller.

Extension Extension for which the call was transferred.

Status This indicates whether you have placed the call on 
hold, or, if the call has returned on time-out.

Label The label indicator is displayed to show that there 
are notes attached to the call. 
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Call Parking Devices Field
The Call Parking Devices field displays a list of call parking devices. By default you can view all 
devices.

Figure 1-10 Displays the Call Park area

You can change the display of devices by clicking on the buttons as explained in the given table,

A Call Park Device with  Out of Service icon indicates that the selected call park device is currently 
out of service. In this case that device cannot be used for parking calls.

You can park or retrieve the Call Park area in the following ways,

 • Using the mouse, select a device in the Call Park area and click any call control button on the call 
control toolbar. These buttons have been explained in the previous sections.

 • Right-click a device and choose an option from the context menu.

 • Use the keyboard shortcuts to perform call control operations as explained in the previous sections.

Table 1-16 Explains functionalities of the buttons available in Call Park area

Button Function

Shows all Call Parking devices.

Displays Call Parking devices available to you.

Shows devices where you have parked calls.

Show Call Parking devices where other operators 
have parked their calls.

Displays the number where you parked the last 
call.

When a call is reverted from a busy extension and 
you park that call, Parked For field will display 
the name of the contact the call bounced back 
from.
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Speed Dial Field (F6)
To enable you to quickly dial calls, a field is provided for frequently called numbers.

Figure 1-11 Displays the Speed Dial area

You can perform call control operations in the following ways,

 • Using the mouse, select a contact click any call control button on the call control toolbar. These 
buttons have been explained in the previous sections.

 • Right-click a device and choose an option from the context menu.

 • Use the keyboard shortcuts to perform call control operations as explained in the previous sections.

Adding an entry to the Speed Dial Field 

To add a number to the Speed Dial field,

Step 1 Point the cursor in the Speed Dials field and right click to select Add Speed Dial.

Figure 1-12 Displays the menu option to add a speed dial number

Step 2 Enter Number, Name and Company name of the contact.
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Figure 1-13 Displays the window where speed dial information is added

The following table explains the fields mentioned in the image above,

Step 3 Click OK.

Timesaver You can simply drag and drop a contact from the Internal/External Directory fields to the Speed Dial area.

Deleting an entry from the Speed Dial Field

Step 1 Select the speed dial you want to delete.

Step 2 Right click and choose Delete Speed Dial.

Table 1-17 Explains the fields displayed on the Speed Dial window

Field Example Description

Private Speed Dial Private speed dial numbers can only be edited 
and viewed by you. Other users logging into 
the application will not be able to view the 
numbers for which this checkbox is selected. If 
unchecked it will be visible to ALL other 
users.

Number 5550111 Contact number to be saved as speed dial.

Name John Smith Name of the contact.

Company CompanyA Name of the company where your contact 
works.
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Figure 1-14 Displays the menu option for deleting a speed dial number

Step 3 Click Yes on the confirmation message.

Figure 1-15 Displays the message that appears to confirm a speed dial deletion

Updating an entry in the Speed Dial field

To update an entry in the speed dial field,

Step 1 Select the speed dial you want to update.

Step 2 Right click and choose Edit Speed Dial.

Figure 1-16 Displays the menu option to edit a speed dial number

Step 3 Change the Name, Number and Company as required.

Step 4 Click OK.
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Working in the Fields
Here are some procedures you can use while working in Attendant Console,

Dialing a Number
Instead of selecting a contact from the directories and then making a call, you can dial a number yourself 
to make a call as well. All you have to do is enter the digits using your keyboard. As you type, the digits 
will appear in the Calling box under the Active Calls area.

Figure 1-17 Displays the calling box where the dialled number appears

The following keys can be used,

Finding Contacts in the Directories
One of Attendant Console’s most powerful features is the search engine. It enables you to search for a 
specific person via configured criteria within the Internal and External directories. This feature is a 
necessity if the console is extremely busy. The procedure for locating people and numbers are listed 
below:

Step 1 If necessary, press the relevant F-Key to select the Internal (F3) or External Directory (F4). This will 
place the cursor in the first box ready for the search. Also if you start typing the cursor will automatically 
go to the first search box.

Step 2 You can select any search criteria. You can base your search on any of the following,

 • Last Name

 • First Name

 • Department 

 • Number

Step 3 Press the Tab key on the keyboard to jump between the search fields or point and click the mouse on the 
relevant search box.

Step 4 Enter a keyword.

Step 5 Press Enter.

The selected directory will filter out any contacts that do not match the keyword that is entered.

Table 1-18 Lists the keys used to edit the dialled number

Key Function

Backspace Clears digits when typing a contact number

Space Bar Clears the number while dialing out.

Enter Dials the entered number.
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Once the required person has been located, either double click or press the Connect key twice to call the 
contact.

Figure 1-18 Displays the results for the search applied using the filters

Note Search will filter contacts that do not match the criteria if the Filter Search button  is pressed. If this 
button is not pressed the application will only select the contact that match the given keyword. For instance, 
if the Filter Search button  is pressed and you type "A" then the first contact that has its first letter "A" 
will be selected.

Lateral Searching (Ctrl^F2)
Lateral Search provides a filter facility to look across a specified criteria (ie Department or First /Last 
Names). This can be used with both the Internal and External contact directories. 

To use the lateral search feature, select a contact from the director either by using the mouse or keyboard, 
then instigate a lateral search by pressing Ctrl^F2 which will display an extended search screen showing 
all contacts matching the lateral search field.

Lateral Searching

The extended search window height can be resized and the window can be moved. The Attendant 
Console will memorize the new size and position of this window. 

The extended search window can be closed at any time using by pressing the ESC (Escape) key or by 
clicking on the close window icon (x).

When you have initiated a Lateral Search, you will need to complete the selection or close the extended 
window prior to continuing with other features within the Attendant Console.

To set the Preferred Lateral Search field you need to specify the criteria within the Preferences. (Options/ 
Preferences and then the Filter Search tab). Selecting None will disable the feature. 
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C H A P T E R 2

Customizing Attendant Console

Revised: February 20th, 2009, OL-18666-01
Cisco Unified Enterprise Attendant Console provides the ability to customize both the appearance and 
functionality of the application. 

To access the console settings, choose Options > Preferences in the main menu. This will open the 
Operator Settings window. The tabs in this window are explained in the following sections,

General
The following settings are available in this section,

Popup Application When

Attendant Console provides you the options to pop up the application when,

 • Queued calls are waiting to be answered

 • My local device rings (if this is the device you are logged in with)

 • Minimize when not in use

If either or both of the first two options are checked, the application will pop up on your desktop if it is 
minimized or hidden. The third option will minimize the application when there are no calls active or 
queuing.

Auto Dial

This option allows you to automatically dial an internal or external number after a defined time. You can 
set the duration of time for Auto Dial. The desired number is entered in the area below Active Calls.

Local Area Code

This field allows you to specify the local country code for the country in which you are located. This 
number is then used to decide how a call should be dialed if it is stored in an international format i.e +44 
(0) 1279 645700. If the Area Code was set to 44 then this call would be dialed as a domestic call i.e 
01279 645700.

Use External Access Number

This option allows you to specify a digit, which is added with the number when an external call is placed. 
This is you standard digit that is used to access an external line, normally a 0 or a 9.
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Use International External Access Number

This checkbox enables you to automatically append an international access code number if a number 
held in an International format is dialed i.e a number with a + prefix. Once this checkbox is checked, 
you must specify the international external access number.

The Voicemail prefix code allows you to transfer a caller into an extension greeting. This will often be 
a * and dialing *5000 would go directly into the Voicemail box of extension 5000.

Figure 2-1 Displays the General tab in the preferences section

Call Transfers
The following option is available in this tab,
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When Dragging and Dropping or Double Clicking

This section allows you to choose the type of transfer you would like to perform when dragging and 
dropping or double clicking a call. You can click a radio button to choose one of the following options:

 • Perform consultation transfer

 • Perform blind transfer

When Blind Transferring

When Blind Transferring a call, Automatic Camp On if busy should be ticked. This will automatically 
stack the call on to the extensionuntil it becomes available. This in turn increases the speed of call 
handling.

When Re-establishing a Call

When Re-establishing a call, Automatic Camp On if busy should be ticked. This will automatically stack 
the call on to the extension until it becomes available. This in turn increases the speed of call handling.

Figure 2-2 Displays the Call Transfer tab in the preferences section

Call Park
This tab provides a checkbox. If you check the checkbox, after a call has been parked, all park devices 
will be displayed in the Call Park Area.
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Figure 2-3 Displays the Call Park tab in the preferences section

Mute
This section allows the user to enable automatic muting of calls. The User can select any of the following 
options:

Performing a search

Selecting this checkbox will automatically mute a call when the operator clicks in any of the search 
fields.

Pressing numeric keys to dial numbers

Selecting this checkbox will automatically mute a call when the operator dials a number.

Changing or selecting Directory screens

If the user selects this checkbox, a call will be automatically muted if the operator clicks on the 
directories.

Figure 2-4 Displays the Mute tab in the preference section.

Tones
This section allows for Tones to be switched on or off depending on specific events happening. The 
Tones are then made by the attendant console when the events occur.
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The following options are available in this tab,

When I have made myself unavailable

This option has a checkbox Do not play any tones. Check this option, if you require that the application 
does not play any tone while you are temporarily absent from the Console Attendant.

When a queued call is waiting to be answered

This option has a checkbox Play a Ring Tone. Check this option, if you require playing a tone while a 
call is waiting in a Queue.

When a call has timed out

This option has a checkbox Play a Ring Tone. You can check this box to signify the reverted call from 
the Call Progress Field, Call Parking Field or other.

Figure 2-5 Displays the Tones tab in the preferences section

Display
The Display tab allows you to set the display settings of the font, tag and reverted reasons. It has the 
following three segments,

When a section becomes selected

This setting allows you to change the font colors of the labels in Attendant Console for the selected area. 
This makes it easy to see which area you have selected when operating the console.

Display Call Information

The Show Routing Tag setting allows you to display the intended destination of each call as well as the 
standard details with each call such as Caller ID and internal/external notification. Show Time-out 
Conditions will include details of why a call has returned to the operator.
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When Making Calls

This settings will enable/disable the BLF/Presence prompt being displayed.

When dragging and dropping

The Display a drag image option allows you to see a complete image on screen of the call you are 
dragging across the screen.

Figure 2-6 Displays the Display tab in the preferences section

Internal Directory 
The Internal Directory is a set of the Internal extensions. Through this tab, you can set the way these 
extensions appear in Cisco Unified Attendant Console. It has the following three segments,

Default Display Order

You can set the Default Display Order in Internal Directory. The drop down list consisting of default 
values is used for selection. The contact list in the directory will be sorted according to the selected 
option.

Show the following information

This section has two list boxes with Available and Displayed values. You can select values from the 
Available and insert them in the Displayed list box. The selected information will be displayed for a 
contact.
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Search Based On

In this segment, you can choose the search fields required to display, which will be used to search a 
record in the Internal Directory. User can choose maximum 6 Search Fields. If the Operator requires 
seeing less than six search fields, selecting the number from the option, I only want to see  
search fields on the screen.

Figure 2-7 Displays the Internal Directory tab in the preferences section

Note Fields that are greyed out denote that they are not indexed within the database.

External Directory 
The External Directory is the list of External numbers for internal contacts. Through this tab, you can 
set the way these extensions appear in Attendant Console. It has the following segments,

Default Display Order

You can set the Default Display Order in External Directory. The drop down list consisting of default 
values that can be selected. The contact list in the directory will be sorted according to the selected 
option.
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  External Directory
Show the following information

This section has two list boxes with Available and Displayed values. You can select values from the 
Available and insert them in the Displayed list box. The selected information will be displayed for a 
contact.

Search Based On

In this segment, you can choose the search fields required to display, which will be used to search a 
record in the External Directory. User can choose maximum 6 Search Fields. If the Operator requires 
seeing less than six search fields, selecting the number from the option, I only want to see  
search fields on the screen..

Figure 2-8 Displays the External Directory tab in the preferences section

Note Fields that are greyed out denote that they are not indexed within the database.
2-8
Cisco Unified Enterprise Attendant Console User Guide

OL-18666-01



Chapter 2      Customizing Attendant Console
  Alternative Numbers
Alternative Numbers
Alternate Numbers Display Order,

It is a list of alternate numbers i.e. Number, Last Name, etc. The user can set their order while 
displaying for the selected Contact. It is recommended that the order presented on this pop up screen is 
the same as the display in Internal Directory F3

Figure 2-9 Displays the Alternative Numbers tab in the Preferences section

Field Headers
You can change the text of Field Headers that appear in the application by simply entering new Display 
Text to replace the Default Text. 
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To change the Display Text for Field Headers,

Step 1 Click on a value in the Display Text column.

Step 2 Type a new Display Text to replace the Default Text.

Step 3 Click OK.

To restore default text, click the Restore Defaults button.

Figure 2-10 Displays the Field Headers tab in the preferences section

Secondary Sort
This tab is enabled only when Attendant Console is logged out. 

You can customize the way Attendant Console sorts and searches the data by specifying a Secondary 
Sort Column.

You can restore defaults if required. The Restore Default button enables when a value is changed from 
the Secondary Sort Column.
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To change the values in Secondary Sort Column,

Step 1 Click on a value in the Secondary Sort Column.

Step 2 A drop down menu will appear with different values related to the values in the Sort Column.

Step 3 Choose a value to replace the previous one.

Step 4 To change more than one value, repeat steps 1-3.

Step 5 Click OK.

Figure 2-11 Displays the Secondary Sort tab in the preferences section
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Filter Search
As you search in any of the search fields with either the Internal or External directories, you can specify 
how you want the search to perform on screen. This tab allows you to set those preferences by selecting 
the following options,

When Searching Names 

Use Phonetic Searching

You can enable this option in order to include a search based on phonetics.

Press Enter to perform search

Once you have entered some information in any one of the search fields, selecting this option would 
perform a search when you press the Enter key.

Search after every key press

This option, when selected, refreshes the search results with every key you press to enter a search value 
in the field.

Search after a delay

If this option is selected and you enter information in the search field, the search result will be displayed 
with a delay specified in the Search Delay section.

Lateral Searching

Lateral Searching provides the facility to look for an alternative contact by pressing the Ctrl^F2 button. 
The selection is made from None, Last Name, First Name, Department or Number.

Selecting None will disable Lateral Seraching.

Figure 2-12 Displays the Filter Search tab in the preferences section
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Primary Server (Information only)
This tab is for information only. It tells you the Server to which you are connected, and the status of that 
connection.

Figure 2-13 Displays the Primary Server tab in the preferences section

Logging
This tab provides for logging files to be switched on and off.

Figure 2-14 displays the Logging tab in the preferences section
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Presence
This tab provides the Operator with the facility to set the preferences for the Presence information.

Default Presence Display

Select between either Cisco Presence Status or None.

Enable Cisco Presence Information

To display the Cisco Presence Information tick this box and select which field will be used to retrieve 
the information.

The selection is made via a drop down selection with the choices being:- Email, Email 2, Email 3, User 
Field 1, User Field 2, User Field 3 or User Profile.

Figure 2-15 Diplays the Presence tab in the preferences section
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C H A P T E R 3

Using Attendant Console

Revised: February 20th, 2009, OL-18666-01
As the heading demonstrates, this section is about the operational flow of the application. It covers the 
topics relating to call management. In this section, you are given instructions on how to work within 
Attendant Console. You must be familiar with the following icons in order to properly handle the calls. 
These icons represent different states of devices in the Internal Directory.

Answering Calls
Attendant Console attends two types of calls,

1. Internal Calls – that are received from a local extension

2. External Calls – that are received from an external number

Calls that are being attended appear in the Active Call Area (F7). 

Table 3-1 lists icons used to reflect the BLF Status

Icon Description

On-hook.

Off-hook.

Unavailable.

Ringing in

Ringing out

Ringing out on busy extension

Connected

Call on hold

Call forwarding 

Notes

Contact not in BLF.
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Figure 3-1 Calls displayed in the Active Calls area

The calls coming into the system are prioritized and queued in the All Queues Area (F8). Calls can be 
answered using the following two methods,

1. Answer Next - Answering the next call in queue.

2. Cherry Picking - Selecting a particular call from the queue to answer.

Answer Next
Incoming calls are prioritized by the system before being displayed on screen. Calls are then displayed 
in the Queued Calls Area (F8) in descending order of priority.

Answer Next is the easiest way to answer incoming calls. This option answers calls in the order of 
priority set by the system. The top priority calls are answered first. 

To answer the next call using the keyboard,

Step 1 Press F8 to select the Queued Calls Area.

Step 2 Press the ‘+’ key on the keyboard and the call will be delivered to your handset.

To answer the next call using the mouse,

Step 1 Right-click in the Queue Area.

Step 2 From the context menu, choose Answer Next.
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The following image illustrates how you can use the context menu to answer the next call. The call with 
the next highest priority will be answered irrespective of which call is selected in the All Queues Area.

Figure 3-2 displays calls being answered through the Answer Next option

Cherry Picking
The incoming calls being displayed can be cherry picked from a specific queue as required.

In order to answer a call you must select a queue and then select the call you wish to answer.

To select a queue using the keyboard,

Step 1 Press F9 to select the Queues field. 

Step 2 Use the up and down arrow keys to select the required queue. 

Step 3 The F8 field will display the calls that are waiting in the selected queue.

Note To revert back to seeing all calls from all Queues, select All Queues icon from F9.

If you are using a mouse, simply click on a queue in the Queues field. After selecting the queue, you are 
ready to take waiting calls.

To answer calls in the selected queues, using the keyboard,

Step 1 Select the All Queues field by pressing the F8 key. 

Step 2 Using the up and down arrow keys, select the call to answer.

Step 3 Press Enter key to connect the call.

To answer calls in the selected queue using a mouse,

Step 1 Select the All Queues field.

Step 2 Click on the relevant call.
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Step 3 Click the  Answer Call button in the call control tool bar.

A personal call direct to your extension will show in the Active Calls field, and ring your handset. You 
can answer by picking up the handset, or by clicking the  Answer Call button.

Timesaver You can simply drag and drop a call from the All Queues field to the Active Calls area to answer.

Transfer Calls
After answering the call, you can transfer it to a requested device, contact or external number. A transfer 
can be made either as a blind or consult (announced) transfer. Calls can be transferred to any available 
destination  either internally or externally.

Transferring a call is straightforward using the mouse or the keyboard and can be completed by either 
entering the desired extension number (if known), or searching the internal or external directories for the 
correct contact.

Initiating A Blind Transfer 

A blind transfer is a call that is transferred without consulting the recipient.

Blind Transferring to a Known Number

To blind transfer a call to a known number using the keyboard,

Step 1 Answer a call or select the call in the Active Calls field.

Step 2 Type in the destination number (internal or external). The cursor will automatically be placed in the Dial 
Box (see below):

Figure 3-3 displays the Dial Box where the dialed number is displayed

Step 3 Double Press the ENTER key quickly to transfer the call.

To blind transfer a call to a known number using a mouse,

Step 1 Answer a call or select the call in the Active Calls field.

Step 2 Using the keyboard type in the destination number (internal or external). The cursor will automatically 
be placed in the Dial Box.

Step 3 Press  Transfer. This will initiate the transfer.

Step 4 Press  Transfer again to transfer the call.
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Blind Transferring to a Directory Contact

If the extension number of the desired recipient is not know you can easily search the Directory to find 
the correct contact. Both the Internal (F3) and External (F4) directories allow searches to be made via 3 
search fields.

To blind transfer a call to a Directory Contact using the keyboard,

Step 1 Answer a call or select the call in the Active Calls field.

Step 2 If searching for a contact using the first displayed search field, simply start typing. The cursor will 
automatically move to the first search field. If you need to use a search field that isn’t the first on the 
screen, use the TAB key to find the right field to type into.

Step 3 As you type, the directory will shrink as contacts are matched (Depending on how Filter Search is 
configured, See Table 2-6, “Filter Search”page 2 - 12). Keep typing until the required contact is found, 
or use the up or down arrow to highlight the contact.

Step 4 Double-click the Enter key to transfer the call.

To blind transfer a call to a Directory Contact using the mouse,

Step 1 Answer a call or select the call in the Active Calls field.

Step 2 Click into the required Search field in either the Internal or External Directory.

Step 3 Start typing and as you type the directory will shrink as contacts are matched. Keep typing until the 
required contact is visible and use the mouse to select the desired contact

Step 4 Double-click the contact to initiate the transfer.

Step 5 Press  Transfer to transfer the call.

Or

Step 1 Point the mouse at the relevant call within the Active Calls field.

Step 2 Press the left mouse button. 

Step 3 Whilst holding the mouse button down, drag the call to the relevant destination within the Internal or 
External Directory field and then release mouse button.

Or

Step 1 Select call details that are displayed in the Active Calls field. 

Step 2 Point the mouse at the relevant destination within the Internal or External Directory or Speed Dial fields 
and click the right mouse button to reveal a Popup menu. 

Step 3 From the popup menu choose Call.

Step 4 Ensure that the call initiated is selected within the Active Calls field. 

Step 5 Click the Complete Transfer button.
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Initiating a Consult Transfer
In this case, the destination of the transfer is consulted before the actual transfer takes place.

Consult Transferring to a Known Number

To consult transfer a call to a known number using the keyboard,

Step 1 Answer a call or select the call in the Active Calls field.

Step 2 Type in the destination number (internal or external). The cursor will automatically be placed in the Dial 
Box (see below):

Figure 3-4 Figure 4: displays the Dial Box where the dialed number is displayed

Step 3 Press the ENTER key to make the enquiry call.

Step 4 After consulting with the destination press the ENTER key to complete the transfer.

To consult transfer a call to a known number using a mouse,

Step 1 Answer a call or select the call in the Active Calls field.

Step 2 Using the keyboard type in the destination number (internal or external). The cursor will automatically 
be placed in the Dial Box.

Step 3 Press  Transfer. This will initiate the transfer.

Step 4 Press  Transfer again to transfer the call after consulting.

Consult Transferring to a Directory Contact

If the extension number of the desired recipient is not know you can easily search the Directory to find 
the correct contact. Both the Internal (F3) and External (F4) directories allow searches to be made via 3 
search fields.

To consult transfer a call to a Directory Contact using the keyboard,

Step 1 Answer a call or select the call in the Active Calls field.

Step 2 If searching for a contact using the first displayed search field, simply start typing. The cursor will 
automatically move to the first search field. If you need to use a search field that isn’t the first on the 
screen, use the TAB key to find the right field to type into.

Step 3 As you type the directory will shrink as contacts are matched (Depending on how Filter Search is 
configured, See Table 2-6, “Filter Search”page 2 - 12). Keep typing until the required contact is found, 
or use the up or down arrow to highlight the contact.

Step 4 Press the ENTER key to initiate the enquiry call.
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Step 5 Press the ENTER key again to complete thet transfer.

To consult transfer a call to a Directory Contact using the mouse,

Step 1 Answer a call or select the call in the Active Calls field.

Step 2 Click into the required Search field in either the Internal or External Directory.

Step 3 Start typing and as you type the directory will shrink as contacts are matched (Depending on how Filter 
Search is configured, See Table 2-6, “Filter Search”page 2 - 12). Keep typing until the required contact 
is visible and use the mouse to select the desired contact

Step 4 Double-click the contact to initiate the transfer.

Step 5 Press  Transfer to transfer the call after consulting.

Or

Step 1 Point the mouse at the relevant call within the Active Calls field.

Step 2 Press the left mouse button. 

Step 3 Whilst holding the mouse button down, drag the call to the relevant destination within the Internal or 
External Directory field and then release mouse button. This sets up the enquiry call.

Step 4 Press  Transfer to transfer the call after consulting.

Or

Step 1 Select call details that are displayed in the Active Calls field. 

Step 2 Point the mouse at the relevant destination within the Internal or External Directory or Speed Dial fields 
and click the right mouse button to reveal a Popup menu. 

Step 3 From the popup menu choose Call.

Step 4 Ensure that the call initiated is selected within the Active Calls field. 

Step 5 Click the Complete Transfer button.

If a transferred call is not answered within a certain time duration, the call is reverted back to the Active 
Calls Area. These calls can then be handled through Reverted Call Controls explained in the latter part 
of the guide.

Making Calls
Cisco Unified Enterprise Attendant Console allows you to dial and make calls. Calls can either be made 
directly to a contact or can be made using different call controls such as Call Parking, Transferring and 
Conference. These call controls are explained in detail, see Table 2-6, “Displays Call Control toolbar 
options”page 1 - 8. There are two types of call that can be made,

1. Internal Call  - Calls that are made to the numbers existing within the system. For example, in a 
call centre, calls made to the numbers within the call centre are called internal numbers.

2. External Call - Calls that are made to the numbers external to the system. For example, an operator 
in a call centre can make a call to a customer for marketing purposes.
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Make an Internal Call
To call a local extension,

Step 1 Enter the required number. No matter which area of the console you have selected, as you type, the digits 
will appear in the Calling box under the Active Calls area.

Step 2 Press Connect/Clear with the mouse or Enter key using the keyboard.

A call will be initiated for the selected contact and the details will be displayed in the Active Calls area.

Making External Calls
To make an external call using a keyboard,

Step 1 Dial the number of the access code and then the external number. (Unless the Attendant Console is 
configured to add the Access Number, See below). 

Step 2 Press Enter key to start dialing.

It is not necessary to place the cursor in the Calling Box, when you start typing the numerical values, it 
will automatically type in it.

To make an external call using a mouse,

Step 1 Select the External Directory using the mouse. 

Step 2 Double click on the number to dial.

Also to make an external call, you can set preferences. The Use External Access Number checkbox 
should be selected and a digit should be there to be added with the number for an external call.

To make an external call with the access number,

Step 1 Check the Use External Access Number box and enter a digit to indicate an External call in the General 
tab of the Preferences.

Step 2 Enter the required telephone number.

It will automatically dial an External call.
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Placing Calls on Hold
While answering a call, Attendant Console can place the active call on hold to answer other incoming 
calls. The call is held on a Service Queue for the time period set as Hold Recall Time in Cisco Unified 
Attendant Admin. After the Hold Recall Time elapses, the status of the call will change from Held to 
Hold Timeout. These calls can be handled through Reverted Call Controls explained in the latter part 
of the guide. A call can be reverted whether the Timeout has been reached or not.

Figure 3-5 displays a call on hold in the Call Progress area

The call will be shown in the Call Progress area and retrieved to the Active Calls area at any time. 

To hold a call through the keyboard,

Step 1 Press F7 key to select Active Calls area.

Step 2 Select a call using up and down arrow keys.

Step 3 Press the (Page down) key to hold the selected call.

To hold a call using a mouse,

Step 1 Select a call in Active Call field.

Step 2 Click the  Hold button.

Retrieving Held Calls
Calls placed on hold can be retrieved from the Call Progress area to Active Calls area. Calls reverted 
from Hold, Park and Transfer can also be seen in Call Progress area. 

To retrieve a held call using keyboard,

Step 1 Press F5 key to select Call Progress area.

Step 2 Select a call using up and down arrow keys.

Step 3 Press the (Page down) key to retrieve the held call.
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To retrieve the held call using mouse,

Step 1 Click on a held call in the Call Progress area.

Step 2 Click the  Retrieve button.

Muting Calls
Attendant Console provides the ability to mute a call when certain actions are being undertaken. There 
are two types of Mute, the first is automated and is set via the Preferences > Mute tab. If this has been 
enabled it can include when a search is being made, when a number is being dialed, or if you are 
changing or selecting Directory screens.

The second type of muting a call is manual and is instigated either by pressing the Mute button  (   ) 
or pressing Ctrl^Q. The same key combination will also un-mute a call. Alternatively you can right click 
on the active call and select Mute from the menu.

Call Parking
Attendant Console provides you with the ability to park calls on to a call parking device. A parked call 
can be picked up from any phone on the CallManager by simply dialing the extension number at which 
the call is parked. You can either park a call on a specific Park Device, or let the system select the device 
for you. You can see the available Call Parking devices in the Call Park area.

To park a call using a keyboard,

Step 1 Press F7 key to select Active Calls area.

Step 2 Select a call using up and down arrow keys.

Step 3 Press the Home key to park the call on one of the available call parking devices.

To park call using a mouse,

Step 1 Select a call in the Active Calls field.

Step 2 Click the  Park Call button.

To Park a call on a specific device using the mouse,

Step 1 Select the call in the Active Calls field

Step 2 Drag the call to the desired Park device and drop the call by releasing the mouse button.

If a parked call is not answered within a certain time duration, the call is reverted back to the Call 
Progress Area. Such calls can then be handled through Reverted Call Controls explained in the latter part 
of the guide.
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Retrieving Parked Calls
To retrieve a parked call using a mouse,

Step 1 Select the relevant call parking device.

Step 2 Click the  Retrieve button.

To retrieve a parked call using the keyboard,

Step 1 Dial the Park device number.

Step 2 Alternatively, if a parked call remains unanswered for a certain period of time (known as Call Park 
Recall), it will revert back to the Call Progress area, from where the Attendant Console can retrieve the 
call using methods stated in Retrieving Held Calls section.

Conference Calls
A Conference call allows you to add a third person to a call session.

With a connected call, to start conference with a 3rd party using a mouse,

Step 1 Select the extension that is to be added into the conference or type the number.

Step 2 Press the Start Conference button and the conference is initiated.

Step 3 Wait for the 3rd party to answer and press the  Conference button.

With a connected call, to start conference with a 3rd party using the keyboard,

Step 1 Select the extension that is to be added into the conference or type the number.

Step 2 Press the End key on the keyboard

Step 3 Wait for the 3rd party to answer and press the End key to join all 3 parties.

Once the conference is in progress an additional field is highlighted in the Active Calls area. The field 
is labeled as Conference Controller and is used to drop you out from the call once all the parties are in 
conversation.
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Figure 3-6 displays a conference call in the Call Progress area

If any of the parties does not respond to the conference call, the call is reverted back. Such calls can then 
be handled through Reverted Call Controls explained in the latter part of the guide.

Note If the third person does not want to start the conference, Attendant Console clears the initiated call. This 
will take you back to the original call.

Re-establish Calls
This feature is a time saver. The re-establishing of calls means to repeat the previous process in a single 
click. From the F5 and F7 fields you can re-establish the calls to undo the previous action as in the 
following areas,

1. Hold Call

2. Transfer Call

3. Conference Call

4. Park Call

If due to some reason the process does not succeed, you can click the Re-establish button to repeat it. 
If you are using a keyboard, press Delete to re-establish.

Toggle Calls
With two active calls in progress, one held and one connected, you can toggle between them.
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When a contact is called for consultation, the incoming call is put on hold. Once the destination accepts 
answers, you can right click on the incoming call in the Active Calls area and choose Toggle. The 
incoming call that was held during consultation will become active. 

On the other hand, the call made to the external contact will be put on hold. You can also toggle using 
the keyboard using the ‘+’ key.

Reverted Call Control
If a call cannot be put through to an extension, it will be returned to the Call Progress Area (F5). This 
may be because the contact could not answer the call in time. Cisco Unified Enterprise Attendant 
Console provides a set of call controls specifically configured to handle reverted calls without having to 
search for the recipient again.

Once the call hits the Active Calls area after being recalled from the Call Progress area, you can view 
the Reverted Call Controls by simply right-clicking on the call.

These call controls are similar to the ones explained previously. The only difference is that in case of 
reverted calls, all the call controls are in context to the contact the call was initially transferred to.

If you right-click on the retrieved call and choose Start Conference, the contact on the extension from 
where the call was reverted will be added to the conference automatically. You would not need to search 
through the directory or specify the extension for that particular contact.

Call Controls for Reverted Calls
The following table gives a brief description of the functionalities that can be performed on a retrieved 
call.

Table 3-2 lists the call controls used on reverted calls

Control Name Icon Description

Clear Call Click to clear an answered call. 

Consult Click to consult and transfer the answered call to the 
extension from where the call was initially reverted.

Blind Transfer Click to transfer the answered call to the extension from 
where the call was initially reverted.

Re-establish Click to redo an action previously performed on the reverted 
call. 

Hold with Notes Click to attach notes to the current call before placing the 
call on hold.

Hold Click to place the reverted call directly on hold for the same 
extension/contact the call was reverted from, without taking 
notes for the contact. 

Contact Properties Click to add or update details of the contact from which the 
call was reverted. 

Start Conference Click to consult and start conference with the contact the 
call was reverted from.
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Right clicking on a call in the Active Calls area and choosing an option from the context menu can also 
perform the above-mentioned operations. You can also access these options using your keyboard (Please 
refer to Chapter 1 Getting Started, Using the Keyboard section).

FAC and CMC Settings
You may need to provide a Forced Authorization Code (FAC) and/or Client Matter Code (CMC) to 
perform an External Blind Transfer. The Administrator configures these codes through Cisco Unified 
Attendant Admin. If this is required during a consultation transfer you will see a dialog box on screen, 
simply enter the correct code and your call will be made.

Forced Authorization Code (FAC)
Forced Authorization Codes are used to provide security in Cisco Unified CallManager for dialing Route 
Patterns. Traditionally, this is used to block calls to external or international numbers. For example, 
often in call centers, only some agents are allowed to make external consult transfers to certain numbers. 
In order to enforce security, these callers are provided with a Forced Authorization Code. The concept 
of FAC is that if you make such an external call transfer that is protected by a FAC, you must enter the 
FAC before the call can continue. If an incorrect FAC is entered, or if no FAC is entered, the call fails.

Figure 3-7 diplays the FAC dialogue box

Client Matter Code (CMC)
Client Matter Codes are used to provide extra call logging facilities within Cisco Unified CallManager. 
This is used to log calls for different clients.

The concept of the CMC is that you must enter CMC Code before an external call or transfer can 
proceed. The call detail records are updated with the CMC code along with the call information. This 
can then be used later on to charge calls to different cost centers.

Camp on Click to transfer a call to a busy Operator.

Park Call Click to place the call on a Call Parking Device.

Table 3-2 lists the call controls used on reverted calls

Control Name Icon Description
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Clearing Calls
In order to disconnect an active call when the enquiry is complete, you need to clear the call from the 
Active Calls area.

To clear a call using the keyboard,

Step 1 Press F7 to select the Active Calls field.

Step 2 Press Enter.

To clear a call using a mouse,

Step 1 Click on a relevant call within the Active Calls field.

Step 2 Right click to open the context menu. 

Step 3 Choose the Clear Call option.

Using Emergency Mode 
Attendant Console allows you to set emergency mode for all the queues. When the queues are in 
emergency mode, all calls are automatically redirected to another destination, Night Service or 
Voicemail for example. These destinations are configured by the System Administrator.

To put a queue in Emergency Mode using the keyboard,

Step 1 From the main menu, choose Options > Emergency.

Step 2 Move the Available Queues to the Emergency Queues list using the  button to move all Queues, or 
the  button to select Queues from the list. The following message box will appear,

Figure 3-8 displays the message box that appears before placing the queues in Emergency Mode

Step 3 Click Yes to move all the queues to emergency mode.

Step 4 Press OK to complete the process.

You can also use the keyboard shortcut to switch to emergency mode. Select the Queue Area and press 
Ctrl^E. The following window is displayed. Click OK to continue.
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Figure 3-9 displays the queues that are placed in Emergency Mode

To take queues out of Emergency Mode,

Step 1 Right click on any selected queue.

Step 2 Select Emergency from the context menu.

Step 3 Click OK to complete the process.

Sending Email
When you forward a call to an extension and it is returned on time out, you have the option to send an 
email to the person to provide important information about the call. The shortcut key for sending email 
is Ctrl^M.

Note There has to be an email address in the Contact Details for the Attendant Console to be able to function.

Call Status
You can view the call status for any device in the Internal Directory. The Status window allows the 
operator to view the status of a contact prior to transferring a call or connecting a contact to a conference 
call.

To view device status,

Step 1 In the Internal Directory, right click on a device.
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Step 2 Choose Status > Calls.

In the Call Status window, you can view the following information,

You can also answer any ringing call by clicking the  Answer button.

Figure 3-10 displays the Call Status window for the selected contact

Contact Properties
Each directory contact will have relevant pieces of information attached to it. Some information will be 
displayed in the Internal and External directories. To see more information for a specific contact a 
Contact Details form can be displayed by pressing the F12 key on the keyboard.

Table 3-3 describes the fields displayed on the Call Status window

Field Example Description

Name John Smith Name of the contact

CLI 2000 This is the number call was made from

DDI 1001 This is the number call was made to

Status Talking The current status of the call
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When a contact is opened information already attached to the contact is displayed, and certain fields will 
be greyed out. This information cannot be changed. All other fields are available for editing as required. 
You can change the details and click on the OK button to save the changes. Please note the fields that 
you can edit are the ones that are not mapped through LDAP synchronization.

Email Contact

If the email address of the contact person is added in the Contact Details, then Attendant Console can 
mail the contact from this window. It will open the mail client configured on your machine. You can click 
the  to write an email.

Figure 3-11 displays the Call Status window for the selected contact

Use Number

In the Contact Numbers tab of the Contact Details window, you can select an external phone number of 
the contact person, and click the Use Number button to automatically dial a number.

Figure 3-12 displays the Call Status window for the selected contact

To edit contact properties using the mouse,
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Step 1 Select a contact from the Internal/External Directory.

Step 2 Right click on the contact to view the context menu. 

Step 3 Choose Properties. 

Step 4 Give the details in the Contact Details window. 

Step 5 Click OK.

To edit contact properties using the keyboard,

Step 1 Press F3 or F4 to select a directory.

Step 2 Use up and down arrow keys to select a contact.

Step 3 Press F12 to open the Contact Properties window.

Step 4 Enter the details for the contact. 

Step 5 Click OK.

Adding Absent Message and Contact Information
It is also possible to add Absent Messages and General Contact Information through the Notes tab. 

Contact Information 

Attendant Console can add extra information with any of the contact in the directories. This information 
will be displayed with the contact as tool tip.

Absent Message

Attendant Console can add an absent message with any of the devices in Internal Directory field.

Note This information is displayed with the contact as tool tip.

Cisco Unified Presence Status
Attendant Console can view CUPs (Cisco Unified Presence) Information for all contacts. IP Phone users 
can now set a status for themselves that is reflected onto Console Operator's Internal Directory. This 
allows you to manage calls efficiently since it can be easily found out whether a particular contact is 
available or not. 
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Figure 3-13 displays CUPs Presence information

Where a contact status has been set, the following presence status icons will be displayed in the Internal 
Directory [F3] and External Directory [F4] windows. The different icons are reflected in the following 
table

To view Presence Status

Step 1 Select a contact in Internal Directory.

Step 2 Hover over a presence status graphic.

Step 3 Presence Status details will be displayed

There is also facility to hover over the contact icon with the mouse and a pop up display will provide any 
additional information that might be available for the status (ie in the case of Vacation it will display a 
return date). 

Table 3-4 CUPs Presence Status Icons.

Icon Status Description

Away Presence status away\be right back.

Busy Presence status busy.

DND Presence status Do Not Disturb (DND).

Offline Presence status offline.

Online Presence status online (available).

Unknown Presence status unknown.
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Operator Call handling
When an operator transfers calls to extensions with a presence status assigned, a message pops up, 
prompting the user that the person the call is being forwarded to currently has a presence status set. The 
figure below shows the message prompt:

To transfer call

Step 1 Select a contact from Alternate Contact Details.

Step 2 The operator can click on any of the following options as required;-

 • Answer Call

 • Call 

 • Consult Transfer 

 • Blind Transfer 

 • Transfer to Voicemail 

 • Hold 

 • Hold with Notes 

 • Start Conference 

 • Park Call 

Step 3 Click Close to cancel.

Table 3-5 Prompt for Presence Status

Control Description

Phone State Displays the current status of the contact. The phone state is represented by 
phone status icon and text.

Name Full name of contact.

Presence Status Description of Presence Status that is assigned to the contact.

Created This specifies the date and time stamp that denotes when the status was last 
modified. This field will show N/A for a presence status of Available.

Do Not Disturb If this option is set, then the message will display "Do Not Disturb" in bold, 
red letters.

Expiry Date This specifies the date at which the presence status expires.

Expiry Time This specifies the time at which the presence status expires.

Alternative Number This specifies the number to which the call must be forwarded. If the number 
is saved in the internal or external directory, contact's full name will be 
displayed instead of the number itself.

Notes This specifies free format text that a user enters to give additional detail of 
his status.

Alternative Contact 
Details

This specifies list of alternative contacts and contacts.
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The following keystrokes may also be used in order to make the desired transfers:

Table 3-6 Keystrokes for transferring a call

Key Description
Enter The call is consulted to the selected alternative 

number.
Enter + Enter The call is blind transferred to the selected 

alternative number.
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Absent Message A little note about the extension when it is not to 
be disturbed or absent.

Busy Lamp Field Set of Internal Extensions assigned to the 
Operator. Operator can monitor their status 
through Cisco Unified Attendant Console.

Call Origin Whether the call is an internal or external call. 
(INT or EXT).

Call Parking Devices Virtual devices where calls can be held 
temporarily and picked from any other call centre 
extension.

CLI Number It is defined as Caller Line Identification The 
caller's number.

Call Status It tells what is currently happening to the call. It 
can be Ringing, Held, Connected or Busy.

Call Type It tells whether the call is an inbound, outbound or 
a transferred call. (IN/OUT/TFR).

Directory Group Set of Internal extensions grouped together to be 
assigned to any Operator afterwards in 
Configuration.

Extension Physical phone in call centre.

External Directory External Directory is the list of External numbers 
for internal contacts.

Field Headers Titles of different sections in Attendant Console.

Internal Directory Internal Directory is the Internal Extensions of 
Call Centre. These are the devices added in Main 
Directory section in Configuration.

Call Queuing The ability for a physical phone to have several 
calls stacked on the line waiting to be answered.

Toggle Changing a call state from help to active or vice 
versa.

Reverted Call A call that hits the Call Progress area if it is left 
unanswered by a contact.
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